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Introduction 
This document details the pre-release of software PSS0223-13: version 2.20 of the 
software for the Mastersizer 3000 laser diffraction system and the new Mastersizer 3000E 
system. It covers software issues fixed and new features introduced. This information is 
required to perform a risk analysis to determine if the software should be installed. In this 
risk analysis the benefits of the new features provided and resolved software issues must 
be weighed against the risk of new issues that may be introduced to vital areas of the 
software or possible changes to the results of future analysis. Installation instructions are 
provided. 

Installation 
It is assumed that you have authority to install or update software within your facility. It is 
also assumed that you have Administrator rights for the system upon which the software is 
installed, as this is a requirement of the installation process. If you do not have this authority 
please consult with your I.T. support department before proceeding. 

Minimum System Requirements 
The minimum requirements for running this software are highlighted in table 1 below. 
Although the software can run using Windows XP Professional and Windows 8 Enterprise, it 
has been fully tested under Windows 7. Windows 7 is therefore the preferred operating 
system. 

Supported Languages 
The Mastersizer 3000 software currently supports operation in the following languages: 

 English 
 French 
 German 
 Japanese 
 Chinese (simplified) 
 Russian 
 Polish 
 Spanish 

The language used by the application is automatically configured based on the operating 
system settings. If you want to force the application to use English instead of the operating 
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system language, you need to start the application using the Mastersizer 3000 (English) start menu shortcut. 

 

Table 1: Minimum system requirements for the Mastersizer 3000 software. 

Feature Specification 

Processor Type Intel Core i5 Processor 

Memory 4GB 

Hard Disk Storage 250GB 

Additional Storage Media CD-ROM or DVD +/-RW drive 

Display Resolution 1024 x 768 

Connectivity 1 high speed USB port 

Operating System Windows 7 (32 bit and 64 bit) 

Windows 8 Enterprise (64bit) 

Installation Instructions 
The software suite comes on an auto-loading CD-ROM. Inserting the drive into a system configured to Auto-run a CD will run the 
installation program automatically. If your system does not support this feature, run the \Mastersizer 3000\setup.exe program from 
your CD drive. 

Note: It is important that the software is installed before the Mastersizer 3000 / 3000E instrument is connected to the computer and 
switched on. This will ensure that the instrument drivers are enabled, and that the firmware updates associated with this release are 
correctly downloaded to the instrument. 

 

Note: Any firmware updates required for your system will be installed at the same time as the software. It is important to keep the 
firmware and software ‘in sync’, since this is the configuration that will have been tested by Malvern Instruments prior to release of the 
software. 

 

Installing the Malvern Access Configurator (MAC) Application 
The software suite includes a copy of the Malvern Access Configurator tool that allows you to manage the security aspects of the 
Mastersizer 3000 / 3000E. The MAC software may be installed either on the PC used to control the instrument or a separate networked 
PC. Installing on a separate PC allows you to manage the security centrally. 

Note: The MAC software does not auto-install. To install this software, navigate to the \Malvern Access Configurator folder on the 
software CD-ROM and run the setup.exe file. 

If you are installing the MAC software on a Windows XP system then you must make sure that the Microsoft .NET framework 3.5 is 
installed first. To install this, navigate to the \Malvern Access Configurator folder and run the dotNetFx35setup.exe file. 

 

As with all Windows applications, the MAC software must be installed by a user who is an administrator on the host computer.  In 
addition, the MAC software uses the existing Microsoft Windows users and groups configured on the host computer to control access to 
the Mastersizer 3000 application. As such, prior to installing the MAC, it is important to ensure that the computer running the Malvern 
software is installed on its host network. If the computer is a stand-alone system, the required users and groups must be configured on 
the computer prior to the use of the MAC.  

Given the above requirements, it is advised that the local IT department review the requirements for use of the MAC application, and are 
present during the software installation process. 
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Note: Please read MRK1828-xx - Guide to setting up access permissions in the Malvern Access Configurator Application and 
MRK1747-xx - Mastersizer 3000 - 21 CFR Part 11 Guide for more information as to how to use the MAC application, particularly when 
operation is required in a 21CFR Part 11 compliant environment.  

Note that operation in 21CFR Part 11 mode is not available for Mastersizer 3000E users. 

Uninstall Procedure 
The software can be uninstalled using the standard Add/Remove Programs feature in the Windows Control Panel. 

Software License Files 
The Mastersizer 3000 software requires a valid license file to run. When connected to an instrument, the system automatically generates 
this file and the user will be asked to accept the license. 

 

Note: If you wish to install the Mastersizer 3000 software on additional computers, you will need to follow the procedure below for 
sharing a software license. 

Sharing a License for Mastersizer 3000 users 
In order to enable the use of the Mastersizer 3000 on a computer which is not connected to a system, it is necessary for users to create a 
license. This can then be shared with other users, allowing them to gain access to the software.  

To share a license, follow the steps below: 

1. At the PC that is connected to the instrument, run the Mastersizer 3000 software and click on the Application Menu icon 

   at the top left of the screen.  

2. Select ‘About’ and click on the View License… button.  

3. Click on the Share this License… button. The system tells you what information the license file contains. 

4. To accept that information click Yes and choose a location to copy the file to (e.g. a memory stick). 

5. At the separate PC, install the Mastersizer 3000 software from the CD and start the program. At the license screen, click the Install 
button. 

Browse to the folder that contains the license file from step 4 above, and select the license file. The licensee details will be shown and 
you can now accept or decline the license. 

 

Sharing a License for Mastersizer 3000E users 
The Mastersizer 3000E system is provided with a simplified, basic version of the Mastersizer 3000 software. This basic software version is 
restricted to use on a single computer workstation attached to the Mastersizer 3000E system. As such, the license sharing facility offered 
for Mastersizer 3000 users is not available.  

Users of the Mastersizer 3000E system who want to be able to use the software on multiple workstations will need to purchase a 
software upgrade. This upgrade will enable the premium features associated with the Mastersizer 3000 software, including the ability to 
create shared licenses. Please contact your local Malvern representative if you would like to purchase this upgrade. 

  

Note: The software license is specific to a given Mastersizer 3000 system. When a license is shared, detailed user and computer 
information is stored in the license file, ensuring it can be traced back to its source Mastersizer 3000 system. Users should only share the 
license with users within their organizations who need to analyze data off-line. The software license must not be shared with other 
organizations without the consent of Malvern Instruments. 
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New Features 
Most of the new features developed for version 2.20 of the Mastersizer 3000 software relate to the launch of a new entry-level 
Mastersizer 3000E product. As this is the first software version designed to support this new system, the features developed for this 
product are not listed here. Instead, the following table lists the new features and improvements included in version 2.20 which apply to 
Mastersizer 3000 system users: 

Reference(s) Feature Comment 

24906 

23085 

26848 

29359 

29079 

Provide support for a new analogue (programmable) level sensor for the Hydro MV (MAZ3210) sample 
dispersion unit. 

New Feature 

29256 Reduce delay in degas sequence Improvement 

10341 Provide surface area result transformation. New Feature 

29692 
Change "Stirrer speed" in custom sample identifiers to "Manual stirrer speed" for the Hydro SM Sop 
template. 

Improvement 

29322 Disable clean sequence options if clean is not selected. Improvement 

29024 Improve usability of the manual alignment controls. Improvement 

28635 
When selecting to batch print reports, only select the currently active reports for printing rather than 
selecting all of the reports available in the reports directory. 

Improvement 

28639 
Enable imported measurement data from older Mastersizer systems to be saved into a Mastersizer 3000 
measurement record. 

Improvement 

27344 Add Skewness as a report parameter. New Feature 

27345 Add Kurtosis as a report parameter. New Feature 

27346 Add Standard Deviation as a report parameter. New Feature 

27393 
Software should default to using the shared workspace when installed, so that all users can find the data 
generated using the Mastersizer 3000 system. 

Improvement 

28291 
Provide a ‘Save As…’ option for reports, so that users can easily create new reports based on existing 
reports. 

Improvement 

26062 Allow selection of manual or automatic fill for Hydro MV / LV clean or fill actions. Improvement 

18929 

18930 

18931 

18932 

18933 

27866 

27867 

27869 

27873 

Provide the ability to import data generated using the Mastersizer X / S / Micro / Micro+ as well as from the 
Mastersizer 2000 / 2000E. 

New Feature 
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29047 
Add ability to generate results which are similar to the new Mastersizer 3000E system to the main 
Mastersizer 3000 software. 

New Feature 

28200 
Provide a simplified display mode which is similar to the new Mastersizer 3000E software within the 
Mastersizer 3000 software. 

New Feature 

 

More details on the use of these new features and the capabilities of the new Mastersizer 3000E system are provided in the New 
Features Description section towards the end of this document. 

Fixed issues 
The main issues fixed in this release of the Mastersizer 3000 software are listed below. 

Reference(s) Issue Comment 

27896 Inconsistent record numbers used for new records when switching between different measurement file 
tabs. 

Fixed 

29184 Exception occurs when editing parameters in a report. Fixed 

29309 Measurement records go into file currently focused record file instead of the one opened at start of 
measurement. 

Fixed 

29473 Report graphs do not update correctly when selecting different measurement records. Fixed 

29859 A message stating that the ultrasound system is operating out of tolerance is displayed when it is working 
correctly, causing measurements to be aborted. 

Fixed 

27421 Dragging the report selector for batch printing during loading freezes the computer. Fixed 

25210 Adding editable parameters to the records view causes the parameter configuration dialogue to stop 
working. 

Fixed 

25212 Default data quality report does not test for zero obscuration. Fixed 

25412 Right-hand side of result tables is clipped when printing on Letter format paper. Fixed 

26466 Dispersion unit settings are not displayed correctly in the SOP summary view for Mastersizer 2000 records Fixed 

26739 System crashes during a manual quick clean. Fixed 

27993 Batch print option is disabled if the Reports tab/view is not selected. Fixed 

28037 System connects to the incorrect accessory type (i.e. one that will not work with the current measurement 
cell) when the software starts.  

Fixed 

28039 At the end of a clean sequence the dispersant valve closes but software reports it is still cleaning, so SOP 
dos not complete. 

Fixed 

28042 Result table overlaps the report footer when printed. Fixed 

28045 Report parameter widgets are shown blank in print outs when operating the software on a French 
language operating system. 

Fixed 

28145 Copying and pasting large numbers of records causes an exception to occur. Fixed 

28153 Constantly starting and stopping measurements can cause measurement manager to lock up. Fixed 

27183 Error occurs when waiting for the vacuum cleaner to start when operating the Aero S via Malvern Link 2. Fixed 

27277 Measurement manager log repeats entries unnecessarily. Fixed 

27308 Measurements made using the Aero S can be saved with water as the dispersant instead of air. Fixed 
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28393 Changing the default printer within the Microsoft Windows operating system settings does not change 
the default printer used for the Mastersizer 3000 software. 

Fixed 

28400 

28670 

29510 

If a manual accessory (e.g. Hydro SM) is used for a measurement, the SOP summary page reported the 
measurement type as being a dry powder measurement. 

Fixed 

28633 Extracted SOP audit history intermittently reports an incorrect SOP version number. Fixed 

28634 An exception occurs if the Extend Result function is enabled without any size values. Fixed 

28675 The scattering data display within the manual alignment window can appear empty. Fixed 

28333 Software can crash when trying to open corrupted measurement or SOP files. Fixed 

29199 Reports are blank if not previewed before printing. Fixed 

29201 Clicking the data quality tab and then back to the reports tab without any records selected puts the 
software in a state where it cannot print any reports even with records then selected. 

Fixed 

29466 An Aero S feed rate error is reported when carrying out short dry measurements, even when the feed rate 
profile is followed correctly. This causes the SOP to stop. 

Fixed 

29475 Delay observed between clicking the start/stop stirrer button in accessory control window and the 
accessory responding. 

Fixed 

29512 

30009 

Software hangs when the USB cable is disconnected from the optical bench. Fixed 

29533 

29588 

Measurement manager displays some text in the local language (e.g. French or Russian) when the 
software is started using the Mastersizer 3000 (English) shortcut. 

Fixed 

29553 Mastersizer 2000 measurement files can be over-written if they are selected in the records view when a 
measurement is started. 

Fixed 

29558 Mastersizer 2000 measurement file import can fail for files created in countries where comma decimal 
separators are used. 

Fixed 

29598 Ultrasound can be reported as being active in a manual measurement even when it is not switched on. Fixed 

29393 Reported laser power value can be reported to 8 decimal point accuracy within the measurement 
manager window. 

Fixed 

29687 Alignment date/time can failed to be stored correctly Fixed 

29763 Occasionally users cannot average records when the accessory control window is open. Fixed 

29790 Software may hang while waiting for obscuration during a manual measurement. Fixed 

29920 Software can crash when selecting different measurement steps within the measurement manager during 
a manual measurement. 

Fixed 

29962 An exception may be reported when deleting large numbers of records. Fixed 

29967 Aero S accessory can fail to each air pressure when changing air pressure during the airflow mode 
initialization sequence.  

Fixed 

30029 The ‘Create Average Record’ function does not correctly handle records containing no result data. Fixed 

30103 File -> Exit does not work routinely when the software focus is on the records view. Fixed 

30126 Meaningless error messages reported when the alignment fails. Fixed 
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30194 Log sheet tab in the measurement manager window should change color to indicate to the user that it 
requires attention. 

Fixed 

30306 Wrong report printed if another report exists which has the same name. Fixed 

30319 Cannot delete reports Fixed 

 

Known Issues 
The following software bugs have been discovered within the software, and will be investigated as part of a future release. Please follow 
the suggested work-around for each issue when operating the software. 

Issue Work Around Comment 

Occasion reports of a firmware update 
failure on start-up. 

If a firmware update is required then the software will download the new 
firmware to the instrument bench and the attached accessories as required.  
If the upgrade process fails then simply restart both the software and the 
instrument bench.  The firmware should update successfully the second time 
through.  

Software Bug 

Some text still appears in English when 
running with a different language 
selected. 

The translation of all software text will continue in future releases. Software Bug 

The Contact Malvern feature in the 
Maintenance window causes the 
software to crash or displays a message 
about the wrong parameter format 
being used. 

Manually email the maintenance report text file to helpdesk@malvern.com if 
support is required. 

Software Bug 

Software does not open all files selected 
when they are opened using Windows 
Explorer. 

Use the Open menu option in the Mastersizer 3000 software to open multiple 
files. 

Software Bug 

An empty error message box is shown in 
the measurement window if the Hydro 
EV accessory is disconnected during a 
measurement. 

Accessories should not be disconnected during measurements. Software Bug 

Reports occasionally appear blank or 
empty even when the record selection in 
the Records View changes. 

Adjust the report zoom slider in the bottom right-hand corner of the report 
window to refresh the display. 

Intermittent 
Software Bug 

Record number and detector number 
values are displayed to one decimal 
place on trend and data graphs. 

No work-around available. A fix will be implemented in a future software 
release. 

Software Bug 

The System Audit displays duplicated 
columns for each language under which 
the system has been run when auditing 
has been enabled. 

No work-around available. A fix will be implemented in a future software 
release. 

Software Bug 

When graph symbols are displayed in 
reports, they do not show on printouts. 

No work-around available. A fix will be implemented in a future software 
release. 

Software Bug 

Various fields in the Edit result window 
lose their ‘edited’ blue background 
appearance when a different page in the 
editor is selected. 

No work-around available. This is a display issue only, as the software 
correctly applies the edit values when the OK button is pressed.  

Software Bug 
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The manual measurement settings do 
not match the connected/active 
dispersion unit. 

See know issue description below.  
Intermittent 
Software Bug 

Mastersizer 3000 driver errors appear 
when using the instrument with a USB 
3.0 port. 

Always use a USB 2.0 port. Software Bug 

Wet accessories can go into standby 
mode unexpectedly when switched on 
for a long period of time. 

When this happens, stop all measurements and then open the Manual 
Measurement, SOP Measurement, or Accessory Control to reactivate the 
accessory. 

Intermittent 
Software Bug 

Downgrading to version 2.01 causes 
exception. 

After installing version 2.10 then downgrading to 2.01, an exception may be 
seen when the software is first started. To work around this, you need to 
delete the Features.xml file from C:\ProgramData\Malvern 
Instruments\Mastersizer 3000\. This will remove 21CFR settings, which you 
will then need to reconfigure. 

Software Bug 

Manual measurement settings do not match the connected / active dispersion unit 
Occasionally, users may see the wet accessory related manual measurement settings when a dry unit is attached, or visa-versa. If this 
occurs, open the manual measurement settings window and click the New menu item from the Window Features menu: 

 

This will reset all measurement settings to their defaults for the active accessory type.  This issue has been reported after upgrading 
from early versions of the software, but does not occur on all systems. 
Backward Compatibility 
This software is only compatible with the Mastersizer 3000 (MAZ3000) and Mastersizer 3000E (MAZ3010) systems, and cannot be used 
with the Mastersizer 2000 (APA2000) or Mastersizer 2000E systems. It is possible, however, to review and recalculate Mastersizer 2000 / 
2000E results within the Mastersizer 3000 / 3000E software. Please refer to the user manuals and software help for guidance as to how 
this is achieved. 
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File Types and Locations 
The Mastersizer 3000 software uses a series of different file types in order to store data and measurement settings. These are described 
below, in order to help users who wish to secure the Mastersizer 3000/3000E system using the Microsoft Windows security and access 
settings. 

File Type Extension Default Path 

21CFR11 mode: Audit trails 

(Mastersizer 3000 only) 

.xml C:\ProgramData\Malvern Instruments\Mastersizer 3000\Audit Trails 

User sizes .siz C:\ProgramData\Malvern Instruments\Mastersizer 3000\User Sizes 

User defined materials .mmat C:\ProgramData\Malvern Instruments\Mastersizer 3000\Materials 

User defined dispersants .mdis C:\ProgramData\Malvern Instruments\Mastersizer 3000\Dispersants 

Data quality addins 

(Mastersizer 3000 only) 

.mdaq Shared workspace: 

C:\ProgramData\Malvern Instruments\Mastersizer 3000\ Workspace\Data Quality 
Addins 

Private workspace: 

C:\Users\{user_name}\Documents\Malvern Instruments\Mastersizer 
3000\Workspace\Data Quality Addins 

Export data .txt, .csv, .rtf Shared workspace: 

C:\ProgramData\Malvern Instruments\Mastersizer 3000\ Workspace\Export Data  

Private workspace: 

C:\Users\KBaines\Documents\Malvern Instruments\Mastersizer 
3000\Workspace\Export Data 

Measurement data .mmes Shared workspace: 

C:\ProgramData\Malvern Instruments\Mastersizer 3000\ Workspace\Measurement 
Data 

Private workspace: 

C:\Users\KBaines\Documents\Malvern Instruments\Mastersizer 
3000\Workspace\Measurement Data 

Reports .mrep Shared workspace: 

C:\ProgramData\Malvern Instruments\Mastersizer 3000\ Workspace\Reports 

Private workspace: 

C:\Users\{user_name}\Documents\Malvern Instruments\Mastersizer 
3000\Workspace\Reports 

SOP templates .msot Shared workspace: 

C:\ProgramData\Malvern Instruments\Mastersizer 3000\ Workspace\SOP Template  

Private workspace: 

C:\Users\{user_name}\Documents\Malvern Instruments\Mastersizer 
3000\Workspace\SOP Template 

SOP .msop Shared workspace: 



 
 

   

  10 
 

C:\ProgramData\Malvern Instruments\Mastersizer 3000\ Workspace\SOP 

Private workspace: 

C:\Users\{user_name}\Documents\Malvern Instruments\Mastersizer 
3000\Workspace\SOP 

Data export templates .mext Shared workspace: 

C:\ProgramData\Malvern Instruments\Mastersizer 3000\ Workspace\Data Template 

Private workspace: 

C:\Users\{user_name}\Documents\Malvern Instruments\Mastersizer 
3000\Workspace\Data Template 

Various system wide 
configuration files 

Various C:\ProgramData\Malvern Instruments\Mastersizer 3000 

Changing the destination path for a particular file type 
The following folders can be configured from within the Mastersizer 3000/3000E software: 

 SOP 
 Measurement Data 
 Reports 
 Export Data 

For Mastersizer 3000 users and those who have upgraded the Mastersizer 3000E software, the default file location for these files can be 
configured via the Target Folders section of the Workspace viewer. To do this, click on the pencil icon which appears when you hover 
over the directory shortcut: 

 

 

 Changing the directory associated with this shortcut will change the default directory accessed by the Mastersizer 3000 software for the 
selected file type. 

Configuration of the target directories can also be configured from the User Preferences-Folders section of the Options menu: 
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Again, hover over the shortcut and click on the pencil icon in order to change the target directory. Note that this is the only place in the 
software where the target directories can be configured when using the Basic software for the Mastersizer 3000E. 

Making a backup of the files 
The Mastersizer 3000 software does not create backup copies of any of the file listed above. However, there are third-party software 
tools that will allow you to schedule regular backups, if required, for each of the file locations. 

Why do you no longer use the Program Files folder? 
With the introduction of Windows Vista and Windows 7, Microsoft changed the default permissions for the Program Files folder to 
prohibit software maliciously changing files associated with installed software. All software runs with standard user permissions on 
Windows Vista/7, even when a user is logged in as an Administrator. By adhering to these default permissions, Malvern’s software 
platforms can execute without additional configuration changes by the end user. 

 

Validation Support Documents 
The Mastersizer 3000 software CD now contains the following documents, which are provided to help users who work within validated 
laboratories: 

 21CFR Part 11 and Security System guides: provide guidance on how to set up the features of the software in order to aid 
technical compliance to 21 CFR Part 11. 

 Generic Audit Questions and Answers: provides users with a answers to the common questions included within postal audit 
questionnaires. 

 IQ and OQ Documents: preview copies of all of the current versions of the Installation Qualification and Operation Qualification 
documents for the Mastersizer 3000 optical bench and accessories. 

 Malvern Instrument’s ISO Certificates: copies of the current Malvern Instrument certificates for ISO9001:2008, ISO14001 and 
OHSAS 18001:2007. 

 QAS Measurement Procedures: copies of the Malvern Quality Audit Standard data sheets and procedures. 
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 Software Certificates of Conformance: copies of the software certificates of conformance for all Mastersizer 3000 software 
versions. 

 Software Update Notifications: copies of the software update notifications for all Mastersizer 3000 software versions, confirming 
the new features and bug fixes introduced for each version. 

 Software Update Verification Procedure: a procedure users can follow for verifying the success of a software upgrade. 

 

Note: The documents provided on the software CD are those which were current at the date the software was released. Please contact 
your local Malvern representative if you need to verify if any updated documents are available. 

 

New Features Description 

Mastersizer 3000E Support 
Version 2.20 of the Mastersizer 3000 software is the first version to provide support for the new Mastersizer 3000E entry level laser 
diffraction system. This system is designed to provide a way for users who do not have a large budget to purchase a system which can be 
upgraded to the full Mastersizer 3000 specification in the future.  

A full comparison of the capabilities of the Mastersizer 3000E compared to the Mastersizer 3000 is provided in the table below:  

Specification Mastersizer 3000 Mastersizer 3000E 

Extended Software 

Mastersizer 3000E 

Basic Software 

Particle size range 0.01m to 3500m 0.1m to 1000m 0.1m to 1000m 

Manual wet dispersion units (Hydro EV and SM)    

Automated wet dispersion units (Hydro MV and LV)    

Automated dry dispersion units (Aero S)    

     

SOP operation    

Customizable reporting    

Entry level legacy system result compatibility tools    

Software bug fixes    

Advanced  method development and comparison tools    

Advanced data quality assessment and reporting tools    

Advanced measurement manager functions     

Measurement sequencing / SOP player tool    

New feature additions and upgrades    

Ability to use the software on multiple workstations    

User workspace functions    

IQ/OQ Validation    

CFR21 part 11 ER/ES    
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The Mastersizer 3000E is, by default, offered with a basic version of the Mastersizer 3000. This can be used with manual wet dispersion 
units only. It also does not include many of the method development and data quality assessment tools provided for the Mastersizer 
3000 software. However, the option to upgrade with Mastersizer 3000E to an Extended software version is available, enabling the users 
to access the full capabilities of the Mastersizer 3000 software, including operation of automated wet dispersion units and the ability to 
create licenses for multiple work stations. This is done via the Extended Software Features section of the Options menu: 

 

Clicking on this option will cause the software to prompt for an upgrade license key. Once this has been provided, the full feature set of 
the Mastersizer 3000 software will be enabled. The Extended Software icon on the software status bar will turn green if the upgrade is 
successful: 

 

Basic Software Mode for Mastersizer 3000 users 
Mastersizer 3000 users operating in QC or production control laboratories may want to simplify the Mastersizer 3000 interface. The Basic 
mode described above for the Mastersizer 3000E can therefore be enabled for the Mastersizer 3000 via the Extended Software 
Features section of the Options menu: 
 



 
 

   

  14 
 

 
 
Three options are available from the Extended Software Features menu, via the drop-down list at the top of the menu: 

 Extended feature set: with this enabled, all of the premium features offered with the standard Mastersizer 3000 software are 
switched on.  

 Basic feature set: all of the premium software features are turned off, causing the interface to work like the Basic software 
provided for Mastersizer 3000E users. 

 Custom feature selection: enables users to select the elements of the premium Mastersizer 3000 software that they would 
like to use within the software. 

Note that these options are also available following upgrade of the Mastersizer 3000E software to Extended mode. 

Producing Mastersizer 3000E results using the Mastersizer 3000 
With the launch of the Mastersizer 3000E, there may be a requirement for users of the Mastersizer 3000 to generate results which are 
the same as those generated using the entry-level system. This may, for instance, help with the transfer of methods and specifications 
between the two systems. In order to allow this to be done, a new advanced analysis option has been provided for Mastersizer 3000 
users, which enables measurements to be analyzed as if they were measured on the Mastersizer 3000E: 

 

 

 

Opening Mastersizer 2000 / S / X / Micro / Micro+ results 
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In previous versions of the Mastersizer 3000 software it has been possible to open Mastersizer 2000 measurement files for review. In 
version 2.20, this functionality has been extended to enable results from the Mastersizer S, Mastersizer X, Mastersizer Micro and 
Mastersizer Micro+ systems to be opened and reviewed. To do this, access the Open-Legacy measurement file ribbon bar menu option: 

 

 
This will cause a file open dialogue to appear where users can select to open either Mastersizer 2000 measurement files (*.mea) or 
Mastersizer S/X/Micro/Micro+ files (*.sam). When the selected file opens it will appear as a read-only file within the Mastersizer 3000 
software. All of the Mastersizer 3000’s reporting capabilities can then be used to review the results contained within the file and compare 
these with Mastersizer 3000 measurement results. 

Recalculating Mastersizer 2000 results 
As mentioned above, it has always been possible to open Mastersizer 2000 measurement files within the Mastersizer 3000 software. This 
function was provided to help with method transfer between the two systems. This capability has now been extended to enable the 
recalculation of Mastersizer 2000 results within the Mastersizer 3000 software. To do this, open a Mastersizer 2000 measurement file 
and then select the Save-As... menu option to save the Mastersizer 2000 results in a Mastersizer 3000 measurement file. If this new file 
is opened, it is possible to recalculate the results using the standard Mastersizer 2000 analysis options. 
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Result Transformations 
In previous versions of the Mastersizer 3000, the ability to transform the volume-based results generated using the system to be number 
distributions was provided in the Data Processing-Result section of the SOP settings. In v2.20, this function has been extended to 
enable surface area distributions to be calculated. 

 

 

Programmable Level Sensor Operation 
Mastersizer 3000 v2.20 software provides support for a revised version of the Hydro MV dispersion unit (part number MAZ3210) which 
has been designed with a programmable level sensor. This enables the level sensor threshold to be set from within the software, which 
may help with the detection of some organic dispersants. 

In order to use a new dispersant with the MAZ3210 unit, users are required to set a threshold value for the level sensor. If this is not done, 
the automated fill and clean functions will not be able to be used with the system. Additional controls have been added to the accessory 
control window to allow the level sensor threshold to be viewed and set. These appear in both the measurement manager and in the 
accessory controls available from the tools ribbon bar menu: 
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Click on the browse  button to select or add a new dispersant. Then, select from the dispersant you want to use from the 
dispersants database, or add a new material: 

 

 
 

A new level sensor threshold entry is available within the Edit Materials Properties dialogue box: 

 
If the threshold value is left blank then the level sensor threshold will be set at zero. The appropriate threshold can be determined by 
filling the tank with the new dispersant. This screenshot below shows the new dispersant selected within the accessory control and with 
the tank empty: 
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Fill the tank with dispersant up to the top of the baffles, as shown below: 

 

 

 

As you fill the tank, the level sensor reading will change, as it starts to detect the liquid. However, the tank will continue to be shown as 
being empty: 

 

 

When you have completed filling the tank, click . This will cause the software to store the sensor reading as being the 
correct threshold setting for your dispersant: 
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Once a level sensor threshold has been stored the tank will be reported as full and the threshold level will added to the dispersant 
database. The automatic fill and clean options will then become available. 
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